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3Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Macintosh, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter are registered trademarks of Apple
Computer, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
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• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

Notes:

Certain options might not be available in some countries. For details, please contact your local dealer.



51. Using PostScript 3

Setting up Options

This documentation describes the specific printer functions and menus that are added by installing the

PPD file. For more information about the functions and menus of the Windows 95/98/Me PostScript

printer driver, see the printer driver's Help.

Preparation

On a Macintosh, Mac OS 8.6 or later (Mac OS X Classic environment is supported.) or Mac OS X

10.1 or later is required.

Limitation

❒ If you use Mac OS X, the following functions cannot be used:

• Sample Print

• Locked Print

• User Code

Note

❒ “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the version, [Features x]

is displayed as [Set x] (x is a number). Make adjustments according to the version you use.
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Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Normal
Select this for normal printing. The print job starts immediately after the print command is given.

Note

❒ Under Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

❖❖❖❖ Sample Print
Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the machine's control

panel. You can also delete the saved job.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the printer.

Windows 95/ 98/ Me [Job Type] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Job Type] on the [Job Log] tab in the Printing Preferences dialog box.

Windows NT 4. 0 [Job Type] on the [Job Log] tab in the Document Defaults dialog box.

Mac OS [Job Type] on [Job Log] in the print dialog box.

Mac OS X This function is not available.
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Note

❒ The “User ID” can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

❒ Entering the “User ID” helps you to distinguish the print job from others.

Reference

For more information about how to use Sample Print, see p.8 “How to Use Sample Print”.

❖❖❖❖ Locked Print
Use this function to save documents in the machine memory with a password, and then edit and print

them as you want.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the printer.

Note

❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”

must be four digits.

Reference

For more information about how to use Locked Print, see p.11 “How to Use Locked Print”.
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How to Use Sample Print 

Follow the procedures to print a document using the “Sample Print” function.

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, sample print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Sample Print.

CCCC Click to select the [Setup] tab.

DDDD Select [Sample Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)

characters.

Note

❒ Select this to identify the user associated with the job.

GGGG Click [OK].
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Sample Print.

CCCC Click to select the [Job Log] tab.

DDDD Select [Sample Print] in [Print Job].

EEEE Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)

characters.

Note

❒ Select this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one set is printed.

HHHH Check the sample print to confirm that the settings are correct.

If the settings are correct, see “Printing the Remaining Sets”, Client Reference.

If not, you can delete the saved job. See “Deleting a Sample Print File”, Client Reference.
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Mac OS

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Sample Print] in [Job Type], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. 

Note

❒ This is used to identify the user associated with a job.

❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

EEEE After making all of the settings you want, click [Print].

The Sample Print job is sent to the machine and one set is printed.

FFFF Check the sample print to confirm that the settings are correct.

If the settings are correct, see “Printing the Remaining Sets”, Client Reference.

If not, you can delete the saved job. See “Deleting a Sample Print File”, Client Reference.
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How to Use Locked Print

Follow the procedures to print a document using the “Locked Print” function.

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, locked print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Locked Print.

CCCC Click to select the [Setup] tab.

DDDD Select [Locked Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ Select this to identify the user associated with the job.

GGGG Click [OK].
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Locked Print.

CCCC Click to select the [Job Log] tab.

DDDD Select [Locked Print] in [Print Job].

EEEE Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ Use this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Locked Print job is sent to the machine.

Mac OS

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Locked Print] in [Job Type], and then select the appropriate setting.



13

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ This is used to identify the user associated with a job.

Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of

multiple-page documents.

Limitation

❒ To use this function, a Memory Unit of at least 192 MB or Hard Disk Drive must be installed on the

printer.

❒ If you use Windows 2000, Windows XP, Mac OS or Mac OS X, make sure that the following check

boxes have not been selected.

• Windows 2000

The [Collated] check box on [Printer Features] on [Advanced...] on the [Paper/ Quality] tab in the

Printing Preferences dialog box.

• Windows XP

The [Collated] check box on [Paper/Output] on [Advanced...] on the [Paper/ Quality] tab in the

Printing Preferences dialog box.

• Mac OS

The [Collate] check box in the print dialog box.

• Mac OS X

The [Collate] check box on [Copies & Pages] in the printer dialog box.
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The following table shows the tabs or menus where you can select this function.

Duplex Printing

Use this function to select duplex printing.

Limitation

❒ To use this function, the optional Duplex Unit must be installed on the printer.

❒ You cannot perform duplex printing from the Bypass Tray.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me The [Setup] tab.

Windows 2000, Windows XP [Collate] on [Printer Features] on [Advanced...] on the [Paper/Quality] 

tab in the Printing Preferences dialog box.

Windows NT 4.0 [Collate] on [Document Options] on the [Advanced] tab in the Docu-

ment Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Collate] on the [Feture 1] tab on [Printer Feature] in the printer dialog 

box.

Windows 95/98/Me [Duplex] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-

erences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the 

Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The [Print on both Sides] check box on [Duplex] in the print dialog 

box.
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You can select the following items: The following items may vary depending on the operating system

you are using.

Windows 95/98/Me

❖❖❖❖ Off
Disables Duplex Printing.

❖❖❖❖ Open to Left
Prints output so that you can open it to the left.

❖❖❖❖ Open to Top
Prints output so that you can open it to the top.

Windows 2000/XP, Windows Server 2003, Mac OS, Mac OS X

Note

❒ If you use a Mac OS, click to select the button that means [Flip on Long Edge] or [Flip on Short Edge].

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the short edge.

❖❖❖❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the long edge.
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Windows NT 4.0

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Short Side
Prints output so that you can open it to the short edge when bound along the short edge.

❖❖❖❖ Long Side
Prints output so that you can open it to the long edge when bound along the long edge.

Color Mode

Use this to select whether the document is printed in color or black and white.

The following table shows the tabs or menus where you can select this function.

Note

❒ If you use Windows 95/98/Me, this mode is called “Color/Black and White”.

Windows 95/98/Me [Color/Black and White] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Color Mode] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Mode:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Mode] on the [Features 1] tab on [Printer Features] in the print 

dialog box.
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You can select the following items:

❖❖❖❖ Color
Prints color documents in full color.

Note

❒ Color images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are

three primary subtractive colors.

❒ If you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from

the Advanced button on the [Paper/Quality] tab.

❖❖❖❖ Black and White
Prints everything, including color documents, in black and white. Black and White printing is faster

than Color printing. To stop black and white areas being printed with CMYK toner, select [Black
and White] in the printer driver as well as in the application.

Paper Selection

All Pages and Destination Tabs

Use this to select the media type and input tray.

Limitation

❒ This function is for Windows 95/98/Me only.

Reference

For more information about the [All Pages and Destination] tabs. See the printer driver's Help.
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Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the paper sizes supported by this printer, see “Paper and Other Media

Supported by This Printer”, Maintenance Guide.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Paper Size:] on [Paper/Output] on [Advanced...] on the [Paper/Quali-

ty] tab in the Printing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document Defaults dialog 

box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

❖❖❖❖ Prompt User
Print is performed with the size of document to be printed unchanged.

❖❖❖❖ Nearest Size and Scale
If the paper size is smaller than the selected papersize, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

❖❖❖❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print is adjusted to meet the

paper size.

Windows 95/98/Me [Fit to Print Size] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Fit to Paper] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Gradation:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Fit to Paper:] on the [Features 1] tab on [Printer Features] in the print 

dialog box.
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Media Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the media type supported by this printer, see “Types of Paper and Other

Media”, Maintenance Guide.

Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Media:] on the [Paper/Quality] tab in the Printing Preference dialog 

box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document Defaults dialog 

box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Paper Type] on the [Features 3] tab on [Printer Features] in the print 

dialog box.
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Paper Source

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Resolution

Use this to set the resolution to [600 dpi].

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Input Tray:] on [All Pages] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Paper Source:] on the [Paper/Quality] tab in the Printing Preferences 

dialog box.

Windows NT 4.0 The [Page Setup] tab in the Document Defaults dialog box.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Windows 95/98/Me This function is not available.

Windows 2000/XP, Windows Server 2003 This function is not available.

Windows NT 4.0 [Graphic] on [Document Options] on the [Advanced] tab 

in the Document Defaults dialog box.

Mac OS This function is not available.

Mac OS X This function is not available.
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Gradation

Use this to select a type of gradation based on your purpose.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Standard
Prints with good quality of gradation.

❖❖❖❖ Fast
Prints quickly while gradation loses some smoothness.

Windows 95/98/Me [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Gradation] on [Printer Features] on [Advanced...] on the [Paper/Qual-

ity] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in the Doc-

ument Defaults dialog box.

Mac OS [Gradation:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-

alog box.
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Color Profile

Use this to select the color profile pattern.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

Important

❒ If you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]

from the[Color] setting. [Automatic] sets the printer to “Auto”.

❖❖❖❖ Auto
Use this setting to configure the best color profile pattern automatically depending on the appear-

ance of the document to be printed.

❖❖❖❖ Photographic
Use this setting to enhance the reproduction of photos and graphics that include midtones.

Windows 95/98/Me [Color Profile] in the [Advanced]dialog box displayed when you click 

[Advanced...], after selecting [Manual] from [Color] on the [Print/Qual-

ity] tab

Windows 2000/XP, Windows Server 2003 [Color Profile] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Profile:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Profile] on the [Features 2] tab on [Printer Features] in the print 

dialog box.
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❖❖❖❖ Presentation
Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD

is best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for

printing photographs, the color or gradations might not be reproduced well.

❖❖❖❖ Solid Color
Use this setting to print specific colors, logos and so on.

❖❖❖❖ User Setting
Use this setting to print images with downloaded CRD from your application.

❖❖❖❖ CLP Simulation
Simulates CLP.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you

should select the appropriate CRD for the document you are printing. The selected CRD is also re-

ferred to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items are available:

[Auto],[Photographic], [Presentation] and [Solid Color].
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Color Setting

Use this to select the correction method used for color conversion.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]

from the [Color] setting. [Automatic] sets the printer to “Super Fine”.

Note

❒ The color rendering dictionary that is selected in the “Color Profile” setting is used.

You can select the following items:

❖❖❖❖ Off
No modification to the color setting.

Windows 95/98/Me [Color Setting] on the [Advanced]window displayed when clicking 

[Advanced...] after selecting [Manual] on [Color] on the [Print/Quality] 

tab

Windows 2000/XP, Windows Server 2003 [Color Setting] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Setting:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Setting] on the [Features 2] tab on [Printer Features] in the print 

dialog box.
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❖❖❖❖ Fine
Select this setting to perform color matching based on one of the printer's built- in color rendering

dictionaries and perform CMYK conversion. This setting performs the printing which output target

is Monitor γ = 1.8.

❖❖❖❖ Super Fine
Select this setting to use a color rendering dictionary as in the “Fine” setting but produce output that

is more vivid. Use this setting to emphasize light colors. This setting performs the printing which

output target is Monitor γ = 2.2.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you

should select the appropriate CRD for the document you are printing. The selected CRD is also re-

ferred to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items are available:

[Auto],[Photographic], [Presentation] and [Solid Color].
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CMYK Simulation Profile

You can simulate the color tone of the printing ink. You can select the printing ink from SWOP, Euro-

scale and JapanColor.

Windows 95/98/Me [CMYK Simulation Profile] in the [Advanced]dialog box displayed 

when you click [Advanced...], after selecting [Manual] from [Color] on 

the [Print/Quality] tab

Windows 2000/XP, Windows Server 2003 [CMYK Simulation Profile] on [Printer Features] on [Advanced...] on 

the [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [CMYK Simulation] on [Document Options] on the [Advanced] tab in 

the Document Defaults dialog box.

Mac OS [CMYK Simulation:] on [Printer Specific Options] in the print dialog 

box.

Mac OS X [CMYK Simulation] on the [Features 3] tab on [Printer Features] in the 

print dialog box.
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Dithering

Use this to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from

[Color] setting. [Automatic] sets the printer to “Auto”.

You can select the following items:

❖❖❖❖ Auto
Use this setting to configure the best dithering method automatically depending on the appearance

of the document to be printed.

❖❖❖❖ Photographic
Performs dithering using an appropriate pattern for photographs.

Windows 95/98/Me [Dithering] in the [Advanced]dialog box displayed when you click 

[Advanced...], after selecting [Manual] from [Color] on the [Print/Qual-

ity] tab

Windows 2000/XP, Windows Server 2003 [Dithering] on [Printer Features] on [Advanced...] on the [Paper/Quali-

ty] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Dithering] on [Document Options] on the [Advanced] tab in the Doc-

ument Defaults dialog box.

Mac OS [Dithering] on [Printer Specific Options] in the print dialog box.

Mac OS X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-

alog box.
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❖❖❖❖ Text
Performs dithering using an appropriate pattern for text.

❖❖❖❖ User Setting
Use this setting to print images set in half tone in your application.

Gray Reproduction

Use this to select the Black Color mode for text and line art.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Black by K
Select this setting to use a black toner.

❖❖❖❖ Black/Gray by K
Black portions are printed in gray.

Windows 95/98/Me [Gray Reproduction] in [Advanced] by selecting [Manual] from the 

[Color] setting. [Automatic] sets the printer to “Pure Black Text”.

Windows 2000/XP, Windows Server 2003 [Gray Reproduction] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Black Text/ Graphics] on [Document Options] on the [Advanced] tab 

in the Document Defaults dialog box.

Mac OS [Black by K] on [Printer Specific Options] in the print dialog box.

Mac OS X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in 

the print dialog box.
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❖❖❖❖ CMY+K
Select this setting to use all toners.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Black Over Print] in [Advanced] by selecting [Manual] from the 

[Color] setting.

Windows 2000/XP, Windows Server 2003 [Black Over Print] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Black Over Print:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Black Over Print] on the [Features 2] tab on [Printer Features] in the 

print dialog box.
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Toner Saving

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Color Control

Use this to select whether or not you want the colors in the documents to be adjusted before printing so

that the printed page matches closer to the colors on the screen.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Toner Saving] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Toner Saver] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Toner Saver] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Toner Saver:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Toner Saving] on the [Features 1] tab on [Printer Features] in the print 

dialog box.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Graphic] on [Advanced] on the [Paper/Quality] tab in the Printing 

Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Print Color] on the [Color Matching] tab in the print dialog box.

Mac OS X This function is not available.
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Note

❒ If you use Windows 2000/XP or Windows Server 2003, this function is called “Image Color Manage-

ment”.

❒ If you use Windows NT 4.0, this function can not be configured.

❒ If you use Mac OS, this function is called “Color Matching”.

❖❖❖❖ Image Color Control
Display the Image Color Matching dialog box, click this button to specify exactly how you want the

colors on your screen adjusted before printing.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to

check the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about using SmartDeviceMonitor for Admin, see Help.

Windows 95/98/Me [User Code] on the [Statistics] tab.

Windows 2000/XP, Windows Server 2003 [User Code] on the [Job Log] tab in the Printing Preferences dialog 

box.

Windows NT 4.0 [User Code] on the [Job Log] tab in the Document Defaults dialog box.

Mac OS [User Code] on [Job Log] in the print dialog box.

Mac OS X This function is not available.
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Options

See “Setting Up Options” in the Client Reference or the Administrator Reference for the installation

method appropriate to your printing environment.

The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Tray 2

• You can select the tray with the following menu for PAPER FEED UNIT Type 1000:

p.21 “Paper Source”

❖❖❖❖ Duplex Unit

• You can use the following function with AD460:

p.14 “Duplex Printing”

Windows 95/98/Me [Options] on the [Accessories] tab.

Windows 2000/XP, Windows Server 2003 [Installable Options] on the [Device Setting] tab.

Windows NT 4.0 [Installable Options] on the [Device Setting] tab in the Document De-

faults dialog box.

Mac OS For ethernet, [Chooser] on the Apple Menu. For USB, [Change Setup] 

from the [Printing] menu to open the Desktop printer

Mac OS X This function is not available.
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❖❖❖❖ Hard Disk

• You can use the following function with Hard Disk Drive Type 2600.

p.13 “Collate”

p.6 “Job Type”

Note

❒ This function is for Windows 95/98/Me only.

❖❖❖❖ Total Memory

• You can use the following function with SDRAM Module (Memory Unit Type C) (64/128/256

MB):

p.13 “Collate”

Note

❒ The optional Memory Unit of at least 192 MB must be installed on the printer.



352. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

Limitation

❒ If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

Note

❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

❒ Printer Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic environment is supported.)

❒ Printer Utility for Mac cannot use Mac OS X (native mode).

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

AAAA Start the Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

CCCC Double-click the icon of hard disk to open it.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [Mac OS] folder.

FFFF Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for Mac]
file, and then drop it into the Macintosh hard disk.

GGGG Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Important

❒ Before starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple

menu.

AAAA Double-click the Printer Utility for Mac icon.

The Printer Utility for Mac dialog box appears.

BBBB Click [OK].

Printer Utility for Mac will take a few seconds to start.

Reference

For more information, see “Printer Utility for Mac Functions”. 
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu

• [Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.38 “Downloading PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk drive. See p.39 “Dis-

playing Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.41 “Initializing the Printer Disk”.

• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.41 “Page

Setup”.

• [Print Font Catalog...]
Print the names of available fonts. See p.42 “Printing Font Catalog”.

• [Print Font Sample...]
Print a sample of fonts. See p.42 “Printing Font Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.42 “Renaming the Printer”.

• [Restart Printer]
Restart the printer. See p.43 “Restarting the Printer”.
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❖❖❖❖ Utility menu

• [Download PostScript File...]
Download a PostScript File. See p.44 “Downloading PostScript Files”.

• [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.44 “Selecting the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.45 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See p.46 “Launching the

Dialogue Console”.

Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important

❒ The following procedures to download the fonts assume that you are a system administrator. If you

are not, be sure to consult your system administrator.

❒ If the printer restarts, all the printer settings return to their defaults.

❒ Confirm that a Mac OS and the printer are connected with Appletalk.

Note

❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation about the fonts you want to use.

AAAA Select [Download PS Fonts...] on the [File] menu.

BBBB Click [Add to list].

The dialog box to select fonts appears.
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CCCC Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

DDDD After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

EEEE Click [Download].

The fonts begin to download, and the download status is shown.

Important

❒ During the download, do not turn off the power switch, operate the panel or open or close the

cover.

FFFF When the completion message appears, click [OK].

GGGG Click [Cancel].

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer's memory

and hard disk drive can be displayed.

Note

❒ The fonts displayed in italics are the default fonts.

AAAA Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Click [OK].
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Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

AAAA Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Select the fonts you want to delete.

Limitation

❒ You cannot delete the fonts displayed in italic.

DDDD Click [Delete].

A confirmation message appears.

EEEE Confirm the fonts you want to delete and the printer name from which you want to delete the

fonts.

FFFF Click [Continue], and then click [OK].

GGGG Click [OK].
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Initializing the Printer Disk

When initializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive are

deleted. Before initializing, be sure to check the fonts on the hard disk drive.

Important

❒ When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's

hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

AAAA Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

Note

❒ To cancel initialization, click [Cancel].

BBBB Click [Execute].

Initializing starts.

Important

❒ Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might

be damaged.

CCCC When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

AAAA Select [Page Setup...] on the [File] menu.

BBBB Choose the paper size.
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Printing Font Catalog

Print the names of fonts available on the printer.

Note

❒ The paper selected under [Page Setup] is used.

AAAA Select [Print Fonts Catalogue] on the [File] menu.

BBBB Click [Print].

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

Note

❒ Print by using the paper selected on [Page Setup].

AAAA Select [Print Fonts Sample...] on the [File] menu.

BBBB Click [Print].

Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect several printers on the

network, assign different names so you can identify them. If several printers have the same name, a digit

appears next to the printer name in [Chooser].

AAAA Select [Rename Printer...] on the [File] menu.

BBBB Type a new name in the [New Name:] field. 
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Limitation

❒ You can enter up to 31 digits and letters.

❒ Do not use symbols, for example “*”, “:”, “=”,”@”, “~”.

CCCC Click [Rename].

The printer name is changed.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Click to select the printer name renamed in step B, and then close [Chooser].

Note

❒ If there are several Appletalk zones, select the zone to which the printer belongs to.

Restarting the Printer

You can restart the printer.

AAAA Select [Restart Printer] on the [File] menu.

BBBB Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note

❒ The fonts that you downloaded in the printer's memory will be deleted.

❒ If the printer restarts, all the printer settings return to their defaults.
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Downloading PostScript Files

You can download a Postscript file to the printer.

AAAA Select [Download PostScript File...] on the [Utility] menu.

BBBB Select the file name to download and click the file name, and then click [Open].

CCCC Type the log file name, and then click [Save].

The selected file is downloaded.

Note

❒ Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs to via Appletalk.

Important

❒ Confirm that the printer and a Mac OS are connected in an Appletalk environment.

AAAA Select [Select Zone...] on the [Utility] menu.

The zone to which the printer belongs to and the available zone list appear.

BBBB Select the zone to which you want to switch the printer, and then click [Change].

A confirmation message appears.

CCCC Click [Continue].

A confirmation message appears.

DDDD Press [OK].
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EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Select the zone selected in step B on the [Appletalk zone:] list.

HHHH Click to select the printer you want to use on the [Select a PostScript Printer:] list.

IIII Close [Chooser].

Displaying the Printer Status

You can display and confirm the current status of the printer.

AAAA Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

BBBB Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status

and available space on the hard disk drive. You can also confirm the zone to which the printer be-

longs to.

CCCC Click [OK].
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Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

Important

❒ “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

❒ Do not download any file other than PostScript files to the printer.

❒ “Launch Dialogue Console” must be used at your own responsibility.

AAAA Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

BBBB Type the PostScript command in the editor screen.

Note

❒ To edit a PostScript file, select [Open] on the [File] menu to open it.

❒ You can search or replace a character string by using the [Search] menu.

CCCC After editing the PostScript file, select [Download Top Window] on [Console] menu to start print-

ing.

The PostScript file is sent to the printer.

Note

❒ The [Reply from Printer] box opens, depending on the PostScript file you sent.

DDDD Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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